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KATA PENGANTAR 
  

Bismillahirrahmannirrahim 

Peningkatan  kualitas  pembelajaran  di  tanah  air  merupakan tanggung  jawab  

semua  elemen  bangsa  Indonesia,  peningkatan kualitas  ini  penting  karena  dengan  

adanya  kualitas  akan meningkatkan  daya  saing  bangsa  kita.  Sebagai  bangsa  yang  

besar, diperlukan  usaha-usaha  yang  besar  pula  guna  mereformasi  semua lini  

pembangunan  bangsa,  terutama  pendidikan.  Pendidikan merupakan  jalur  penting  setiap  

anak  di  Indonesia  yang  tentu  saja mereka akan menjadi penerus bangsa ini.  

  Buku ini disertai dengan latihan secara langsung di depan komputer dan disertai dengan Tugas 

setiap babnya.   

Tidak  ada  gading  yang  tidak  retak  dan  tentu  saja  buku  ini  masih banyak  

kekurangannya,  mohon  masukan  yang  sebanyaknya  untuk perbaikan di edisi selanjutnya.   

  
Salam sukses,  
  
  
Penyusun  
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Pertemuan 1 

Pengenalan PowerPoint 2007 
  

 

1. Menjalankan Microsoft PowerPoint 2007                        
Klik  tombol   Start  >  All  Program  >  Microsoft  Office  > Microsoft Office PowerPoint 2007.  

  

2. Pengenalan Interface/Tampilan Microsoft PowerPoint 2007 

        

Pada  windows  Microsoft  Powe r  Point  2007  yang  muncul, terdapat  beberapa  tampilan  

sebagai  berikut  (tunjukan  dengan  mouse anda masing– masing komponen berikut) :  

 
 

 

3. Mengaktifkan Menu- Menu Pada  Power Point 2007 

 
 

a. klik  tab  Menu   Home   atau  tekan   Alt+H.   

b. klik Menu   Insert   pada tab menu atau tekan  Alt+N   

c. klik  tab Menu   Design    atau  tekan   Alt+ G.   

d. klik  tab  Menu Animations atau  tekan      Alt+A.    

e. klik  tab  Menu Slide Show  atsu tekan  Alt+S.  

f. klik tab Menu  Review atau  tekan   Alt+Rl.   

g. klik tab Menu  View atau tekan  Alt+W.   

h. klik  tab  Menu  Developer  atau tekan  Alt+L.    

i. klik tab Menu   Add-Ins   atau  tekan   Alt+Xl.   

  

Tip  :  Jika  mouse  anda  terdapat  tombol  scrollnya,  

maka  anda  dapat berpindah  dari  satu  menu  ke  menu  

lainnya  dengan  menggeser tombol scroll yang ada pada 

mouse anda.   
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4. Membuat Dokumen Baru Dalam Microsoft PowerPoint  2007    

a. Klik  Office Button  >  New .  

b. Pada  Kotak  Dialog  yang  muncul  

Pilih  > Blank  &  Recent  >  Blank 

Presentation  > klik tombol  Create .   

c. Kemudian  akan  muncul  jendela  

presentasi  di  layar  monitor  anda, 

jendela presentasi yang muncul ini adalah 

slide judul presentasi.  

d. Pada Slide yang muncul ketikkan seperti 

gambar di samping:   

e. Kemudian kita  akan membuat  slide  

kedua  caranya pilih    New Slide  > 

Title & Content.    

f. Kemudian akan bertambah slide ke-2  

 

Ketikkan di Judul :  Laporan Lab 1  

Untuk isi silahkan ketikkan:  
Pada kegiatan Lab 1 ini, diperlukan sumber 1 liter air limbah rumah tangga. Peralatan lainnya 

adalah 1 buah sendok makan dan 1 buah toples, dan 1 buah termometer.  

g. Langkah  selanjutnya  menambah  slide  ke-3  klik  New  Slide > Two Content.  

 

   

  

5. Menyimpan Dokumen Presentasi    
Kemudian  simpan  hasil  kerja  anda,  dengan  mengklik Office  Button > Save   atau  tekan  

tombol Ctrl+S Beri nama (nama sendiri).    

  

6. Menutup Presentasi       
Untuk  menutup  hasil  presentasi  anda,  klik  tanda      close  (X)   di  pojok kanan atas,  atau  

bisa  juga dengan menekan  tombol   Office  Button > Close  atau Ctrl+F4.  

 

  

7. Tugas Pertemuan 1   
        

Buatlah  dokumen  presentasi  baru,  kemudian  ketikkanlah  dokumen “ Tugas Pertemuan 1. ” 

berikut dan setelah selesai simpan dengan nama “latihan (nama anda)” .  

  

Slide 1.  
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Slide 2.   

 
  

Slide 3.  

 
 .  

Slide 4.  
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Pertemuan 2 

Memulai Sebuah Presentasi 
  

1. Membuat Dokumen Baru Dalam Microsoft PowerPoint  2007  
          

a. Klik  Office Button > New  atau anda 

dapat menekan  Ctrl+N .  

b. Pada Kotak Dialog yang muncul Pilih  

Blank & Recent > Blank Presentation .   

c. Kemudian  akan muncul jendela  

presentasi  di layar  monitor  anda,  

jendela presentasi yang muncul ini adalah 

slide judul presentasi.     

d. Pada  slide  yang  muncul  ketikkan  

seperti  terlihat  pada  gambar  di  

samping :  

e. Kemudian  tekan  tombol   Ctrl+S   

untuk  menyimpan  dokumen  presentasi 

anda.  

 

  

2. Menambahkan Slide Baru Dalam Presentasi 

a. Masih  menggunakan  file  sama kemudian  kita  akan membuat slide kedua caranya pilih  ikon  

New Slide > Two Content.     

b. Kemudian ketikkanlah teks presentasi kita seperti terlihat di bawah ini.  

 
c. Kemudian  coba  anda  tambahkan  kembali  satu  slide  yang  baru,  dan buatlah tampilannya 

sebagai berikut.  

 
d. Kemudian  simpan  hasil  kerja  anda,  dengan  menekan  tombol Ctrl+S .  Kemudian  coba  

anda  jalankan  presentasi  anda  dengan  menekan tombol   F5. 

e. Untuk  berpindah  ke  slide  berikutnya   klik  sekali   pada  mouse anda.  Jika  telah  selesai  

klik  tombol ESC  pada  keyboard  anda  untuk kembali ke tampilan normal.   

  

 

3. Menyimpan Dokumen Presentasi  Dengan Nama Lain 
Setelah  anda  simpan  hasil  kerja  anda,  anda  juga    bisa  menyimpannya   dengan  nama  

lain  ataupun  format  file  lainnya.  Caranya  Klik  Microsoft Office Button > Save As .                                                                  
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   Jenis file ekstensi                          

Beberapa tipe data yang bisa anda pilih:  

1.    .pptx : Untuk ekstensi PowerPoint 2007  

2.    .ppt : Untuk powerpoint 97-2003  

3.    .pot : pemyimpanan template standar  

4.    .gif : penyimpanan dalam format gambar (gif)  

5.    .jpg : penyimpanan dalam format gambar (jpg)   

   

4. Membuat Presentasi Menggunakan Template   

a. Klik   Office Button > New.  

b. Pada  kotak  dialog  window  yang  muncul,  pilih      Installed  Templates  > Contemporary 

Photo Album  atau pilih kategori lain sesuai keinginan anda, kemudian klik  Create .   

   

Anda akan mendapatkan tampilan seperti ini :  

  
 

 

c. Kemudian  gantilah  teksnya  sesuai  dengan  latihan  sebelumnya,  sehingga tampilannya 

seperti di bawah ini.  

d. Setelah  selesai  simpanlah  (Ctrl+S) 

   

  

5. Tugas Pertemuan 2           
   

1. Buatlah sebuah presentasi sederhana dengan pengaturan sebagai berikut:  

a. Gunakan fasilitas presentasi baru yang masih kosong.  

b. Buatlah 5 buah slide dengan isi sebagai berikut:  

  

Slide 1     
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Slide 2    
 

 

  
 

 

 Slide 3    

 
 

 

 

 

Slide 4  

 
 

  

Slide 5  

 
2.    Simpan dokumen anda dengan nama “latihan 2 (nama anda)” . 
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Pertemuan 3  

Mengatur Tampilan Kerja 
 

  

1. Membuka File Dokumen Presentasi 
        

1. Untuk membuka file yang akan kita atur tampilannya, klik  Office Button > Open.  

2.  Pada  kotak  dialog  yang  muncul,  arahkan  ke  folder  tempat  anda menyimpan  file   

Tugas  Pertemuan  2 ,  kemudian  pilih  file   Tugas  Pertemuan  2, kemudian klik tombol  Open.    

  

 

2. Pengenalan  Beberapa Tampilan 

 

a. Setelah  file  kita  buka,  untuk  mengatur  tampilan  presentasi  kita,  klik  tab           

menu  View > Normal.  Coba anda perhatikan tampilannya.   

b. Kita  akan  belajar  melihat  beberapa  tampilan/view  Presentasi, klik        View, kemudian  

klik  Slide  Sorter,  akan  menampilkan  semua  slide  yang  ada dipresentasi anda.   

c. Kemudian  klik   Notes  Page,   akan  muncul  tampilan  dalam  bentuk  notes yang berguna 

menambah catatan disetiap presentasi anda.   

d. Selain  menggunakan cara  di  atas, anda  bisa  juga menggunakan  tampilan di  layar  

presentasi  di  kanan  bawah,  klik    normal,  slide  sorter  dan  slide show.  Dibagian  

kanan  untuk  memperbesar  dan  memperkecil  tampilan slide sendiri.  

 
 

  

3. Bekerja dengan Tampilan Area Outline  

 

a. Masih  menggunakan file  Tugas Pertemuan 2.  Kemudian ke tampilan normal, dan klik 

“Outline”.  

b. Pada Tampilan menu outline ini anda, bisa mengedit secara langsung isi presentasi  jika  anda  

inginkan.  Klik  slide  di  bagian  outline,  lalu  ganti teksnya,  ataupun  secara  mudah  anda  

bisa  menambah  dan  menghapus slide.  

 

  

4. Bekerja Dengan Slide   
a. 1. Masih  menggunakan  file   Tugas  Pertemuan  2.   Sekarang  klik  bagian   Slides ,                

tambahkan sebuah  slide  sesudah slide 5  dengan mengklik  kanan  di slide 5, lalu klik  New 

Slide .  

b. Kemudian ketikkan isi slide baru dengan isi sebagai berikut:  

 
 

c. Kemudian  hapus  slide  ke-5,  caranya  klik  kanan  di  slide  ke-5  lalu  pilih Delete Slide .   

d. Kemudian  slide  ke-5  akan  terhapus,  untuk  membatalkan  perintah  

e. penghapusan  tadi  klik   Ctrl+Z    (undo)   dan  slide  akan  kembali  lagi, kemudian tekan 

tombol  Ctrl+S.   
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 5. Bekerja dengan Tampilan Slide Sorter 
a. Masih  menggunakan  file   Tugas  Pertemuan  2.   Klik   View  >  Slide  Sorter .  

b. Pindahkan slide 3 ke slide 5 dengan cara klik slide 3, lalu     klik kanan > Cut.    

c. Slide  3  akan  terhapus  lalu  klik  di  antara  slide  4  dan  5,  kemudian           klik 

kanan > Paste.   

d. Kemudian  kita  akan  memperbanyak  slide  yakni  slide  4  akan  kita  copy. Caranya  

adalah  klik  slide  4, lalu   klik  kanan  > Copy ,  kemudian  klik  di luar slide 5 lalu klik 

kanan dan klik Paste.   

e. Kemudian  tutuplah dokumen presentasi anda dengan  cara  tekan tombol Ctrl+W,   kemudian  

pada  kotak  dialog  Save   pilih  tombol   No,   agar perubahan dokumen presentasi tidak 

disimpan.  

 
  

   

6. Bekerja Dengan Tampilan Notes Pages 
a. Buka kembali file “ Tugas Pertemuan 2”.  

b. Klik tab menu  View > Notes Pages.  

c. Pada bagian  Notes  ketikkan  “Manfaat Obat lami”.  

 
 

d. Setelah  selesai  klik  kembali    menu View  >  Normal.   Perhatikan perbedaanya.  

e. Kemudian coba  anda jalankan presentasi anda dengan menekan tombol     F5.  

f. Untuk berpindah ke slide berikutnya  klik  sekali  pada mouse anda. Jika  telah selesai klik 

tombol  ESC   pada keyboard anda .   

 

7.  Tugas Pertemuan 3          
Ketikkan  dokumen  presentasi  ini,  kemudian  setelah  selesai  simpan dengan nama  “ Tugas 

Pertemuan 3 (nama) ” .   

  

Slide 1.  
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Slide 2.     

  

Slide 3.  

  

Slide 4. 
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Pertemuan 4   

Mengatur Layout dan Themes 
  
 

1. Memilih Dan Mengganti Layout/Tampilan Slide 

 

a. Buka kembali file presentasi  “Tugas Pertemuan 3”    

b. Aktifkan Slide 1.   

c. Klik  tab  menu   Home  >  Layout  >  Title  and  Content, perhatikan perubahannya.  

d. Coba  anda    terpakan  untuk  layout  dan  slide  yang  lain  sesuai kebutuhan anda.  

 

  

2. Menggunakan Themes Slide       
a. Masih menggunakan file presentasi  “Tugas Pertemuan 3”  

b. Aktifkan slide yang akan diterapkan Themesnya (slide 1).  

c. Klik tab menu  Design,  kemudian klik  menu  More Themes.  

 
  

d. Pada  kotak  dialog  themes  yang  muncul,  pilih  jenis  themes nya, misalnya   Opulent.   

Coba  anda  perhatikan  perubahannya.  Maka sekarang semua slide mempunyai themes yang 

sama.  

e. Coba  anda  terapkan  untuk  jenis  themes  yang  lainnya,  kemudian setelah selesai, simpan 

kembali file anda   (Ctrl+S).  

 

  

3. Menggunakan Multiple Themes Dalam Satu Presentasi 

 

a. Masih menggunakan file presentasi “Tugas Pertemuan 3”                    

b. Aktifkan slide 2.  

c. Klik tab menu  Design,  kemudian klik  menu  More Themes.  

d. Klik kanan pada jenis Themes  Oriel > Apply to Selected Slides.  

 
e. Kemudian klik slide 3.   

f. Klik  kembali  ikon   More  Themes   (lihat  materi  sebelumnya),  kemudian klik  kanan  

pada  jenis  Themes       Flow  >  Apply  to  Selected  Slides. Perhatikan perubahan pada 

slide persentasi anda.  

g. Coba  anda  terapkan  masing-masing  slide  dengan  themes  yang berbeda.  

 

  

4. Mengedit Format Themes        
a. Masih menggunakan file presentasi   “Tugas Pertemuan 3”                   

b. Aktifkan slide 3.  

c. Klik tab menu  Design > Colors > Slostice.  Lihat perubahannya.  
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d. Klik  menu  Font > civic,  perhatikan perubahan huruf pada slide 3. 

 
e. Coba anda lakukan penggantian jenis huruf pada slide yang lainnya.  

   

5. Membuat Custom Themes Color Slide/Warna Thames Baru 

 

a. Masih menggunakan file presentasi  “Tugas Pertemuan 3”                   

b. Aktifkan slide 4.  

c. Klik  tab  menu   Design  >  Colors  >  Create  New  Theme  Colors. Lihat perubahannya. 

 
d. Pada kotak  dialog  yang muncul, tentukan campuran warna  yang anda inginkan.  Misalnya  

gunakanlah  campuran  warna  seperti  terlihat  di bawah ini.  

e. Ketikkan nama “ warna baru”  yang  kita buat pada  bagian  kotak dialog Name.  

 

f. Kemudian  klik  tombol   Save,   nah  sekarang  lihat  perubahanya  pada slide 4. Coba anda 

buat lagi warna themes yang baru untuk slide yang lainnya.  

g. Kemudian coba anda  jalankan presentasi  anda dengan menekan  tombol  F5.  Untuk berpindah 

ke slide berikutnya  klik sekali  pada mouse anda. Jika  telah  selesai  klik  tombol   ESC     

pada  keyboard  anda  untuk  kembali  ke tampilan normal.  

  

 

6.  Tugas Pertemuan 4          
Ketikkan  dokumen  presentasi  ini,  kemudian  setelah  selesai  aturlah designnya  menggunakan  

themes  yang  ada  sehingga  tapilannya  seperti terlihat di bawah ini. Setelah selesai  simpan 

dengan nama “Tugas Pertemuan 4 (nama)”   

  

Slide 1.  

 
Slide 2.  
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Slide 3.   

  
Slide 4.  

   
Slide 5.  
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Pertemuan 5  

Memodifikasi Background Slide & Format Teks 

 

  
1.  Mengganti Background Slide Dengan Warna Solid 

a. Masih menggunakan file presentasi  “Tugas Pertemuan 4”    

b. Aktifkan slide 1.  

c. Klik tab menu  Design > Background Styles > Format Background.  

 
d. Pada  kotak  dialog  yang  muncul   pilih      Solid  fill,   centang  pilihan   Hide 

Background graphcs,  warna pilih biru, kemudian klik tombol  Close. 

    
e. Sekarang  coba  anda  perhatikan  perubahannya.  anda  bisa  mengganti warna sesuai 

keinginan anda.  

  

2.  Mengganti Background Slide Dengan Warna Gradien 
a. Masih menggunakan file presentasi  “Tugas Pertemuan 4”    

b. Aktifkan slide 1.  

c. Klik tab menu  Design > Background Styles > Format Background.  

d. Pada  kotak  dialog  yang  muncul  pilih Gradient  fill,   kemudian  pada  bagian  Preset 

Colors  pilih warna yang anda inginkan, misalnya  Silver.  

e. Kemudian  pada  bagian   Type   pilih   Radial ,   Direction   pilih   From  Center  

misalnya  Silver.  Kemudian klik tombol  Close.  

f. Nah  sekarang  lihat  perubahan  pada  slide  anda.  Anda  juga  dapat  mengganti tipe 

gradient dan direction sesuai kebutuhan anda.  
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3.  Mengganti Background Slide Dengan Gambar/Picture 

 

a. Masih menggunakan file presentasi  “Tugas Pertemuan 4”    

b. Aktifkan slide 1.  

c. Klik tab menu  Design > Background Styles > Format Background.  

d. Pada  kotak  dialog  yang  muncul  pilih   Picture  or  texture  fill,   kemudian klik tombol  

File.  

e. Pada  kotak  dialog  yang  muncul,  pilih  folder  dan  gambar  yang  ingin anda  masukkan.  

Misalnya  pilih  pada  folder Sample  Picture Kemudian klik tombol  Insert.  

f. Kemudian klik tombol  Close.  Coba anda perhatikan perubahannya pada slide anda.  

g. Coba  anda  ganti  background  untuk  slide  2,  3  dan  4  dengan  gambar/picture  yang  

anda  inginkan.  Setelah  selesai  tutup  dan  simpanlah dokumen presentasi anda.  

  

4.  Mengatur Format Font dan Paragraf dalam Slide            
a. Masih menggunakan file presentasi  “Tugas Pertemuan 4”                    

b. Aktifkan slide 1.  

c. Seleksi/ pilih teks judul slide 1.  

d. Kemudian klik tab menu   Home > Font. 

  
e. Selanjutnya  pada  kotak  dialog  yang  muncul,  aturlah  jenis  huruf  dan  style  serta  

efeknya  sesuai  yang  anda  inginkan.  Misalnya  isikanlah  formatnya seperti terlihat di bawah 

ini. Kemudian klik tombol  OK.  

f. Coba anda perhatikan perubahan teks anda.  

 

 

5.  Mengatur Jarak Spasi Antar Huruf/Character 

 

a. Masih menggunakan file presentasi  “Tugas Pertemuan 4”    

b. Aktifkan slide 1.  

c. Seleksi/ pilih kembali teks judul slide 1. Kemudian klik tab menu Home > Font.    

d. Pada  kotak  dialog  yang  muncul,  klik  pada  tab Character  Spacing , kemudian  aturlah  

jarak  hurufnya,  misalnya  seperti  terlihat  di  bawah ini. Kemudian setelah selesai klik tombol  

OK.  
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e. Nah  sekarang  anda  perhatikan  kembali  perubahan  pada  teks  anda.  

f. Maka jarak antar huruf sekarang menjadi lebih lebar.  

  

 

6.  Mengatur Format Perataan Paragraf Dalam Slide.           
a. Masih menggunakan file presentasi  “Tugas Pertemuan 4”    

b. Aktifkan slide 2.  

c. Seleksi/ pilih isi teks pada slide 2.   

d. Klik  tab  menu   Home   kemudian  klik  ikon  perataan  paragraf  rata seimbang/ justify  

(Ctrl+J).  Perhatikan perubahannya. 

 

  
 

  

Kemudian  coba  anda  jalankan  presentasi  anda dengan  menekan  tombol F5.  Untuk 

berpindah ke slide berikutnya  klik sekali  pada mouse anda. Jika  telah selesai klik tombol  ESC   

pada keyboard anda.  

  

7.  Tugas Pertemuan 5          
Buatlah  dokumen  presentasi  baru,  kemudian  ketikkanlah  dokumen “ Tugas Pertemuan 5. ” 

berikut dan setelah selesai simpan dengan nama “Tugas Pertemuan 5 (nama)”.   

.  

  

Slide 1.    

  
Slide 2.   
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Slide 3.   

 
.  

Slide 4.   

  
Slide 5.  



 
DIR COMPUTER : Jl. Nangela-Kopo Kp. Nangelapasar Ds. Nanggung-Kopo 

 
17 

     

 
Pertemuan 6  

Memodifikasi Presentasi Dengan Menyisipkan Gambar, Audio Dan Video 
  

 

1.  Menambahkan Objek Gambar Ke Dalam Slide 
a. Buka Kembali file  ”Tugas Pertemuan 5”   

b. Aktifkan slide 1, kemudian klik tab menu  Insert > Picture.  

c. Kemudian  Pada  kotak  dialog  yang  muncul,  tentukan  folder  tempat gambar  disimpan  

(tergantung  dimana  anda  menyimpan  gambar), kemudian klik gambar anda, dan klik tombol  

Insert.  

d. Nah  sekarang  perhatikan  slide  anda. Untuk  mengatur  ukurannya,  anda dapat  klik drag /  

klik tahan tarik  pada bagian  size button.  

   

  

2.  Menggunakan Style Dan Efek Gambar 

a. Masih menggunakan file presentasi ”Tugas Pertemuan 5” 

b. Aktifkan gambar yang akan kita beri style pada slide 1.  

c. Klik  tab  menu   Format,   kemudian  klik  ikon  style   Reflected  Rounded Rectangle   

pada  bagian  ribbon   Picture  Styles.    

 
d. Kemudian  Perhatikan perubahan gambar anda.  

e. Kemudian coba sekarang klik ikon  Picture Shape > Teardrop.   

  
f. Nah  sekarang  coba  anda  perhatikan  perubahan  pada  gambar  anda. Kemudian cobalah 

gunakan bentuk objek shape yang lain.  

g. Kemudian  sekarang  coba  klik  ikon Picture  Border  >  Red.   Perhatikan kembali 

perubahan pada gambar anda.  

h. Kemudian  sekarang  coba  klik  ikon Picture  Effects  >  3D  Rotation. Kemudian pilih  



 
DIR COMPUTER : Jl. Nangela-Kopo Kp. Nangelapasar Ds. Nanggung-Kopo 

 
18 

Isometric Left Down.  

   
i. Perhatikan  kembali  perubahan  pada  gambar  anda.  Anda  juga  dapat menggunakan Efek 

3D yang lainnya sesuai dengan kebutuhan anda.  

  

3.  Menyisipkan File Video Ke Dalam Slide Presentasi 
a. Masih menggunakan file presentasi  ”Tugas Pertemuan 5”   

b. Aktifkan  slide  2.  Kemudian  klik  tab  menu      Insert  >  Movie  >  Movie  from Clip 

Organizer. 

  
c. Kemudian  pada  kotak  dialog  yang  muncul,  pilih  file  movie,  kemudian  klik salah satu 

ikon  movie tersebut dan kllik  menu Insert.  

d. Nah  kemudian  jalankan  presentasi  anda  dengan  cara  tekan  tombol   F5.  

e. Kemudan  klik  sekali  pada  mouse  anda,  dan  perhatikan  file  movie  yang  

f. kita  masukkan  pada  slide  ke  2.  Tekan  tombol  ESC   untuk  kembali  ke  

g. tampilan desingn slide.  

  

4.  Menyisipkan File Suara/ Sound Ke Dalam Slide Presentasi  
a. Masih menggunakan file presentasi ”Tugas Pertemuan 5” 

b. Aktifkan  slide  3.  Pastikan  komputer  anda  telah  dilengkapi  dengan            speaker.  

Kemudian  klik  tab  menu Insert  >  Sound  >  Sound  from  Clip Organizer.  

 
c. Kemudian pada kotak dialog yang muncul, klik  ikon  Music Land > Insert.  

d. Pada  kotak  yang  muncul,  klik  tombol         Automatically,   agar  sound dimainkan  

secara  otomatis  ketika  presentasi  dijalankan dan  memasuki slide ke tiga.  

e. Kemudian  coba  anda  perhatikan  pada  slide  3  anda,  ikon         sound   telah 

ditambahkan ke dalam slide  anda.  Untuk  melihat  efeknya  tekan  tombol F5   untuk  

menjalankan  presentasi  anda,  kemudian  klik  mouse  anda sehingga sampai pada slide 3, 

maka suara musik akan anda dengarkan.  

  

5.  Tugas Pertemuan 6        
Buatlah  dokumen  presentasi  di  bawahi  ini  dengan  menggunakan  bantuan  materi  yang  

telah  kita  bahas  pada  Pertemuan -Pertemuan  sebelumnya.  Gambar dapat anda sesuai keinginan 

anda, dan tambahkan  file video dan  sound ke  “Tugas Pertemuan 6 (nama) ”.  dalam  presentasi  

tersebut.  Setelah  selesai  simpan  dengan  nama  
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Slide 1    

  
 

 

 

Slide 2   
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Pertemuan 7  

Memodifikasi Presentasi Menggunakan Animasi 
  
 

1.  Menggunakan Animasi Dalam  Slide 

a. Bukalah kembali dokumen presentasi  “Tugas Pertemuan 6”   

b. Aktifkan slide 1. Aktifkan  place holder text  judul.  

c. Klik tab menu  Animation > Animate > Fly In.  

 
d. Coba  anda  tekan  tombol   F5,   kemudian  klik  sekali  mouse  anda  dan  lihat hasilnya,  

maka  animasi  akan  dijalankan.  Setelah  selesai  tekan  tombol ESC.  

 

2.  Menggunakan  Custom Animation 

a. Masih menggunakan file dokumen presentasi  “Tugas Pertemuan 6”   

b. Aktifkan slide 1. Aktifkan sub judul teks.  

c. Klik tab menu  Animation > Custom Animation.  

 
d. Kemudian  pada   task  pane  Custom  Animation ,  klik   Add  Effect   >   

Entrancekemudian  pilih  efek  anaimasi  untuk  masuknya  teks  yang  ada  atau  klik More 

Effects  untuk memilih efek yang lebih banyak lagi. 

    
e. Kemudian pada kotak dialog yang muncul, pilihlah jenis efek animasi yang anda inginkan, 

misalnya  Circle  kemudian klik tombol  OK.  

f. Nah kemudian jalankan  presentasi  anda   (F5) ,  dan klik sekali pada mouse anda  perhatikan  

efeknya, dan klik sekali lagi kemudian lihat  kembali efek yang muncul. Tekan tombol  ESC  

untuk kembali ke tampilan normal.  

g. Kemudian  klik/aktifkan  kembali  teks  isi  slide  1,  kemudian  klik  ikon Add Effect  >  

Emphasis  >  More  Effects,   kita  akan  memberi  efek  setelah  efek Entrance/ masuk.  

h. Kemudian pada kotak dialog yang muncul, pilih jenis efek yang ingin anda gunakan, misalnya  

Spin,  selanjutnya klik tombol  OK.  

i. Kemudian  coba  jalankan  presentasi  anda  dan  perhatikan  efek  yang muncul.  Nah  

kemudian  coba  anda  terapkan  juga  efek Emphasis tersebut untuk teks judul slide 1.  

j. Sekarang aktifkan  kembali teks judul dari slide 1, kemudian klik kembali tab menu  Animation >  

Custom Animation >  Add Effect > Motion Paths > More  Motion  Paths,   menu ini  untuk  

membuat  efek dengan  objek path/ garis kurva.  

k. Pada  kotak  dialog  yang  muncul,  pilih  jenis  efek  path  yang  ingin  anda gunakan,  
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misalnya  gunakanlah  efek   Bounce  Right.   Kemudian  setelah selesai klik tombol  OK.  

l. Perhatikan perubahan pada  slide  1  anda. Untuk  melihat  efek yang  kita buat,  jalankanlah  

presentasi  anda  dengan  menekan  tombol F5,   dan jangan  lupa  untuk  mengklik  mouse  

anda  untuk  melihat  satu  persatu efek-efek  yang  ada  dalam  slide  1  kita.  Setelah  

selesai  kembalilah  ke tampilan normal dengan menekan tombol   ESC.  

m. Selanjutnya  aktifkan kembali  teks judul  slide  1, kemudian pilih  kembali tab  menu   

Animation  >  Custom  Animation  >  Add  Effect  >  Exit  >  More Motion Paths > More 

Effects  

n. Kemudian pada kotak dialog yang muncul, jenis efek keluarnya teks dari presentasi  kita,  

misalnya  gunakanlah       Dissolve  Out,   kemudian  klik tombol   OK.   Jalankan  

presentasi  anda  dan  lihat  perubahan  efek  yang terjadi.  

 

  

3. Memodifikasi Efek Animasi Slide 
 

a. Masih menggunakan file dokumen presentasi “Tugas Pertemuan 6” 

b. Aktifkan slide 1. Aktifkan judul slidenya.  

c. Kemudian  klik  tab  menu   Animation  >  Custom  Animation   

kemudian  pilih jenis efek yang pertama dari teks kita dan pilih   

Effect Option  (perhatikan gambar di samping).  

d. Kemudian  pada  kotak  dialog  yang  muncul,  klik  tab        

Effect   pada  bagian Direction/ arah efeknya  misalnya pilih  

From Bottm,  Aktifkan  Smooth end, pada  bagian   Sound   

misalnya  pilih   Arrow     untuk  memunculkan  suara ketika  

efek  dijalankan,  dan  pada  bagian      Animate  text   pilih   

All  at  once  agar  teks  muncul  seluruhnya  ketika  efeknya  

berjalan.  Kemudian  klik tombol  OK. 

 
e. Kemudian sekarang klik tab  Timing.   Pada bagian  Start  pilih  After Previous  untuk  

membuat  efek  berjalan  secara  otomatis  setelah  efek  sebelumnya telah  selesai berjalan.  

Delay  isikan   0,  agar efek animasi langsung berjalan tanpa  harus  menunggu  waktu/delay,   

Speed   pilih  kecepatan  jalanya  efek 

teksnya,  misalnya  gunakan   Medium,  

Repeat   isikan  2,  agar  efek  diulang dua 

kali ketika kita jalankan.  

f. Nah  selanjutnya  klik  tab   Text  

Animation,   kemudian  pada  bagian   

Group text   pilih   All  Paragraphs  At  

Once   agar  efek  berjalan  secara  

bersamaan pada semua paragraf teks yang 

ada. klik OK.   

g. Lakukan  hal  yang  sama  untuk  efek  

animasi  yang lainnya pada slide 1 kita.    
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4.  Menghapus Efek Animasi Slide      
a. Masih menggunakan file dokumen presentasi  “Tugas 

Pertemuan 6”  

b. Aktifkan slide 1. Aktifkan  place holder text  judul slidenya.  

c. Kemudian  pilih  efek  animasi  yang  akan  dihapus,  

misalnya  efek  animasi yang pertama/  Entrance,  kemudian 

klik tombol  Remove.  

d. Nah sekarang coba anda perhatikan, sekarang efek animasi 

yang kita pilih telah terhapus.  

  

 

 

5.  Mengatur Durasi Tampilan Slide      
a. Masih menggunakan file dokumen presentasi  “Tugas Pertemuan 8” 

b. Aktifkan slide 1. Kemudian klik tab menu   Slide Show > Rechearse Timings.  

 
c. Kemudian  pada  kotak  dialog  yang  muncul,  anda  akan  mulai  merakam waktu  untuk  

slide  anda,  untuk  merekam  slide  selanjutnya,  klik  tombol Next.  Lakukanlah perekaman 

samapai slide yang terakhir.  

d. Nah  jika  telah  sampai  pada  slide  terakhir,  maka  akan  muncul  kotak dialog  peringatan  

apakah  kita  akan  menyimpan/  menerapkan  waktu yang  kita  rekam  untuk  

masing-masing  slide  kita,  klik  tombol        Yes   untuk menyimpannya.   

e. Coba anda jalankan presentasi anda, dan perhatikan perubahannya.  

  

 

6.  Menggunakan Efek Perpindahan Slide   
a. Masih menggunakan file dokumen presentasi  “Tugas Pertemuan 8” 

b. Aktifkan slide 1.  Klik  tab menu   Animation  > Dessolve,   kemudian  aktifkan centang  

Automatically After,  dan klik tombol  Apply To All.  

  
c. Kemudian coba anda jalankan presentasi anda, dan lihat perubahannya.  

  

     

7.  Tugas Pertemuan 7        
Buatlah  dokumen  presentasi  di  bawah  ini  dengan  menggunakan  bantuan materi yang telah 

kita bahas pada Pertemuan-Pertemuan sebelumnya. Gambar dapat anda sesuaikan dengan keinginan  

anda. Aturlah masing-masing  durasi slide  “Tugas  Pertemuan 7  anda.  Kemudian  setelah  

selesai  simpan  dengan  nama  “Tugas Pertemuan 7 (nama anda)”.   

  

Slide 1.   

 
Slide 2.  
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Slide 3.  

   
Slide 4.  

   
Slide 5.  

   
Pertemuan 8 Memodifikasi Presentasi  Dengan Menyisipkan Table, Grafik, Dan Wordart  
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1.  Menyisipkan Tabel Dalam Slide Presentasi 
a. Buka kembali file presentasi  “Tugas Pertemuan 7”   

b. Aktifkan slide 5, kemudian klik  menu  Home > New Slide > 

Blank.  

c. Klik tab menu  Insert > Table > Insert Table.  

d. Pada kotak dialog yang muncul, isikan  Number of columns: 3, 

Number of rows : 9,  kemudian klik tombol  OK. 

  
e. Kemudian pada tabel, ketikkan isi tabelnya sebagai berikut :   

 
f. Pilih  baris  pertama  dari  tabel,  kemudian  klik  tab  menu Layout  >  Merge Cells,  maka 

cell dalam tabel akan digabungkan.  

  

2.  Menambahkan Grafik DalamPresentasi 
a. Masih menggunakan tabel di dalam file presentasi “Tugas Pertemuan 7” 

b. Tambahkanlah satu kolom  baru pada tabel, kemudian isikan data seperti terlihat di bawah ini. 

   
c. Maka  akan  muncul  slide  yang  baru.  Klik  tab  menu           Insert  >  Chart. 

d. Kemudian  pada  kotak  dialog  yang  muncul,  pilihlah  jenis  grafik  sesuai yang  anda  

butuhkan,  misalnya  pilih  seperti  terlihat  pada  gambar  di bawah ini.  

e. Kemudian ketikkanlah datanya sebagai berikut.  
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f. Setelah  selesai  klik  tombol   Close   pada  pojok  kanan  atas  windows. 

g. Kemudian  aktifkan  grafik  anda,  klik  tab  menu Layout  >  Chart  Title  > Above Chart.   

h. Kemudian ketikkan  “Grafik Distribusi Tingkat Kelangkaan Tumbuhan”.   

i. Kemudian  klik    menu   Axis  Titles  >  Primary  Horizontal  Axis  Title  > Title Below 

Axis.  

j. Kemudian  ketikkan   “Jenis  Perawatan”,   kemudian  coba  anda  lakukan  “Tingkat  

Perawatan”.  untuk  Vertical  Axis  Title  dengan  isi  teks                           Jika telah 

selesai maka tampilannya adalah sebagai berikut.  

 
 

3.  Menambah  Diagram Dalam  Presentasi 

a. Buat kembali file presentasi yang baru.   

b. Klik  menu  Home > New > Blank Presentation > 

Create.  

c. Kemudian klik tab menu  Insert > SmartArt.  

d. Pada  kotak dialog SmartArt Graphic, pilih   Cycle 

> Basic Radial,  kemudian klik tombol  OK.  

e. Aktifkan salah satu shape lingkarannya, kemudian klik tab menu Design > Add Shape Before.  

Perhatikan hasilnya.  

f. Coba  anda  tambahkan  2  shape  lagi.  

g. Kemudian ketikkanlah isi dari diagramnya sebagai berikut.  
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 4.  Tugas Pertemuan 8         
Buatlah  Dokumen  Presentasi  dengan  tampilan  seperti  di  bawah  ini.  

Setelah selesai simpan dengan nama  “ Tugas Pertemuan 8” .   

  

Slide 1.   

  
Slide 2.  

  
Slide 3.  
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Slide 4.  

  
Slide 5.  

  
 

 


